
NORTON CrashGuard
CrashGuard runs in the background and monitors your system for crashes. It recovers from the crash and lets you save any 
unsaved data.

Anti-Freeze
Anti-Freeze unfreezes a frozen application a program that is still on your screen but is not responding to input from you or 
Windows. When you notice that an application is frozen, you can pop up Anti-Freeze and unfreeze the application.

Settings
Lets you select the types of crashes CrashGuard intercepts. You can choose to protect your PC from crashes caused by either 16-
bit applications, 32-bit applications, or both. This option also lets you trigger any type of crash to test the ability of CrashGuard (or 
any other crash-protection program) to recover from the resulting crash.

LiveUpdate
LiveUpdate connects you to the Symantec Internet site, downloads the latest CrashGuard updates and patches, and installs them 
on your PC. You must have a modem and/or an Internet connection (direct or dial-up) to use LiveUpdate.
Click here {button ,EF(`crashgrd.hlp',`',1,`')}    to open the Help Contents.



Anti-Freeze
Anti-Freeze unfreezes a frozen application a program that was running and is still on your screen but is not responding to input 
from you or Windows 
When you discover that your application is frozen, Anti-Freeze might be able to unfreeze the application.
Click here {button ,EF(`crashgrd.hlp',`',1,`')}    to open the Help Contents.



Settings
Lets you select the types of crashes CrashGuard will intercept. You can choose to protect your PC from crashes caused by either 
16-bit exceptions, 32-bit exceptions, or both. 
This option also lets you generate any type of exception to test the ability of CrashGuard (or any other crash-protection program) to 
recover from the resulting crash.
Enhances the Close Program dialog box (which appears when you press Ctrl+Alt+Del) to include an Anti-Freeze button. This lets 
you apply Anti-Freeze to a frozen program even if the entire system stops responding. (This option does not apply to Windows NT.)
Click here {button ,EF(`crashgrd.hlp',`',1,`')}    to open the Help Contents.



LiveUpdate
Connects you to the Symantec Internet site, downloads the latest CrashGuard updates and patches, and installs them on your PC. 
Note:

You must have a modem and/or an Internet connection (direct or dial-up) to use LiveUpdate.
Click here {button ,EF(`crashgrd.hlp',`',1,`')}    to open the Help Contents.



Using the Norton Anti-Freeze dialog box
Anti-Freeze unfreezes a frozen application a program that was running and is still on your screen but is not responding to input 
from you or Windows 
When you discover that your application is frozen, Anti-Freeze might be able to unfreeze the application.
Recovering from crashes and freezes:
When you use CrashGuard and Anti-Freeze to recover from crashes and freezes, you should not assume that everything is 
back to normal. The crash or freeze could be a symptom of more serious problems with the application. In general, you should:

Save your work as best you can.
Exit the offending application.
Restart the application.

Click here {button ,AL(`anti-freeze',0,`',`')}    for related information.



Saving your work
Follow these tips when saving your work:

Because your document or data file might have been damaged by the crash or freeze, you should first try to save your 
work into a new file using the Save As command (in the File menu of most applications). This way, the original file, which might still 
be sound, will remain intact.

If Save As does not work, try the Save command. But be aware that, even if the save seems to succeed, the next time 
you try to open the document, it might not open because of the possible damage, or it might need extensive repair.

If the Save or Save As commands do not work, try selecting the entire document (many applications have a Select All 
command in the Edit menu) and copying it to the clipboard with the Copy command (in the Edit menu of most applications). If you 
close the program and start it again (without shutting down Windows) you should be able to paste your work from the clipboard into 
a new blank work space.

Some programs include an Export command (often In the File or Tools menu), which might let you save your document in 
a different format. If an application has an Export command, it will likely have a corresponding Import command that you can use to 
reclaim your work after you exit the application.

If none of these techniques work, you can try printing your document or copying it down by hand so that you at least have 
a solid record of your work.
Click here {button ,AL(`anti-freeze',0,`',`')}    for related information.



Partially disabled applications
Follow these tips to work with partially disabled applications:

Some freezes might be only partial; for example, the application might stop responding to the keyboard, but will still 
respond to the mouse. Try clicking the application’s menu, since that is the portion most likely to work and probably contains the 
commands you need most, such as Save, Copy, and Export.

After a freeze or crash, some parts of a program might stop responding while other parts still work. If the program was 
showing a dialog box at the time of the malfunction, try clicking its Cancel button or pressing Esc to make it go away. Do not click 
other controls unless you really need them, since they might be part of the malfunction.

Sometimes the shape of the mouse cursor can become frozen and its functionality will be other than what its shape 
indicates. If the mouse cursor is an hourglass (or some other special-purpose shape), try clicking the application anyway.

As you try to recover, some commands or controls might cause the program to crash or freeze. But CrashGuard and Anti-
Freeze should catch those problems too, so just keep trying until you manage to save your work by one of the methods above.
Click here {button ,AL(`anti-freeze',0,`',`')}    for related information.



Norton CrashGuard Settings dialog box
Use this dialog box configure CrashGuard’s crash protection, test the 16-bit and 32-bit exception handler, and to view CrashGuard 
statistics.
Crash Protection:

Configure whether CrashGuard traps and fixes crashes caused by 16-bit and 32-bit applications.
If you do not use any 16-bit applications (for example, older programs written for Windows 3.x), you can leave the Enable 16-bit 
Crash Protection check box unchecked.

Enhances the Close Program dialog box (which appears when you press Ctrl+Alt+Del) to include an Anti-Freeze button. 
This lets you apply Anti-Freeze to a frozen program even if the entire system stops responding.

The option to add Anti-Freeze to Ctrl+Alt+Del does not appear in the Settings dialog box under Windows NT because Anti-

Freeze is always accessible in the menu that appears when you right-click the CrashGuard icon  in the taskbar.
Statistics:

View the number of crashes and freezes CrashGuard intercepted.
Click Details to view detailed information about the crashes CrashGuard has trapped and the frozen applications it has 

unfrozen.
Click here {button ,AL(`exceptions',0,`',`')}  for related information.



Norton CrashGuard Statistics dialog box
This dialog box displays:

How many crashes you have had.
How many freezes you have had.
Which applications and modules caused the errors.

Note:
The applications named TEST16.EXE and TEST32.EXE are CrashGuard's exception-generating programs that are run 

when you click Test in one of the Crash Test dialog boxes. If either application shows up in this list, those crashes were probably not 
encountered during "normal" computing.
Click here {button ,KL(`exceptions',0,`',`')}  for related information.



Using the 16-bit Crash Test dialog box
Use this dialog box to generate any of the 16-bit exceptions listed. This tests CrashGuard’s ability to trap and fix the resulting crash.
To generate an exception:
1 Select the exception you want to generate.
2 Click Generate.
Note:

As you select each exception, a detailed description of it appears near the bottom of the dialog box.
Click here {button ,AL(`exceptions')}  for related information.



16-bit Exceptions
Norton CrashGuard traps crashes caused by the following 16-bit exceptions:
General Protection Fault
The program tried to examine data that is off-limits or does not exist.
Invalid Opcode
The program tried to execute an instruction that is not recognized by the processor.
Divide By Zero
The program tried to divide a number by 0. This is an arithmetic problem for which there is no solution, so the computer cannot 
calculate the result.
Stack overflow
The program used too many automatic variables or nested function calls too deeply.
Click here {button ,AL(`exceptions')}    for related information.



Using the 32-bit Crash Test dialog box
Use this dialog box to generate any of the 32-bit exceptions listed. This tests CrashGuard’s ability to trap and fix the resulting crash.
To generate an exception:
1 Select the exception you want to generate.
2 Click Generate.
Note:

As you select each exception, a detailed description of it appears near the bottom of the dialog box.
Click here {button ,AL(`exceptions')}    for related information.



Opening Anti-Freeze
To launch Anti-Freeze from the desktop:

Right-click the CrashGuard icon 

 in the taskbar and select Anti-Freeze.
The Anti-Freeze dialog box appears, listing all the programs you can apply Anti-Freeze to.
Select the program which is not responding and click “Unfreeze” to apply Anti-Freeze to it. If the program does not start 

responding, or if it immediately freezes again, you can apply Anti-Freeze again.
To activate Anti-Freeze when the system does not respond:

Press Ctrl+Alt+Del once. After a pause, Windows displays the Close Program dialog box which lists all running programs. 
If you are running Windows NT, see the note below.

If you select a program in the list which is appropriate for the use of Anti-Freeze, the Anti-Freeze button will be enabled. 
Anti-Freeze does not operate on certain hidden system programs or drivers.

If one of the programs is labeled “[Not Responding]” you should concentrate on it first. A single frozen application can 
cause the entire system to freeze. This is called blocking, and it occurs because the system is waiting for that program to finish a 
particular action.
Note:
Pressing Ctrl+Alt+Del to access Anti-Freeze is not an option under Windows NT. Anti-Freeze is always accessible in the menu that 
appears when you right-click the CrashGuard icon in the taskbar.

Click here {button ,AL(`anti-freeze')} for related information.



Closing CrashGuard
To close CrashGuard:

1 Right-click the CrashGuard icon  in the taskbar.
2 Select Close. A dialog box appears and ask you to confirm that you want to close CrashGuard.
Notes:

Closing CrashGuard this way removes it from memory and prevents it from protecting your system against crashes. (To 
restart CrashGuard, see Launching CrashGuard.)

If a running program has become dependent on CrashGuard to keep operating, CrashGuard continues to provide 
protection to that particular program until it closes.
Click here {button ,AL(`crashguard')}    for related information.



Closing a frozen application
Sometimes an application cannot be satisfactorily unfrozen. (For example, an application might freeze because the data it is working
with has been damaged. Anti-Freeze might unfreeze the application but then the application immediately freezes again because of 
the damaged data.) In such cases, you might need to close the frozen application.
To close a frozen application:
1 Close Anti-Freeze (if it is still open).
2 Press Ctrl+Alt+Del to display Windows' Close Program dialog box.
3 Select the frozen application in the list of running applications.
4 Click End Task.
Click here {button ,AL(`anti-freeze')}  for related information.



Configuring CrashGuard
To configure CrashGuard:

1 Right-click the CrashGuard icon  in the taskbar.
2 Check the “32-Bit Crash Protection” item  to let CrashGuard trap and fix crashes caused by 32-bit applications.
3 Check the “16-Bit Crash Protection” item  to let CrashGuard trap and fix crashes caused by 16-bit applications.
4 Check the “Add Anti-Freeze to Ctrl+Alt+Del” item  to make the Anti-Freeze feature available from the Close Program 
dialog box. (The Close Program dialog box appears when you press Ctrl+Alt+Del.) This option does not apply to Windows NT users.
Note:

You can also configure CrashGuard by clicking Settings in the main CrashGuard shield.
Click here {button ,AL(`settings')}    for related information.



32-bit Exceptions
Norton CrashGuard traps crashes caused by the following 32-bit exceptions:
Access Violation

The program tried to examine invalid data. This means that there is either no information at that location, or the information is off-
limits to the program.

Array Bounds Exceeded
The program tried looking off the end of an array. In other words, the program looked off the end of a finite-sized table it has in 
memory.

Breakpoint
A breakpoint marks a place where the program should stop when being tested by the original programmer.

Datatype Misalignment
Some programs use datatype-alignment to ensure the program knows what type of data it is using. Such programs will stop with 
this error if they try using the wrong type of data.

Float Denormal Operand
The program performed arithmetic using numbers too small to be represented in the normal way. Such numbers are called 
"denormalized" numbers.

Float Divide By Zero
The program tried to divide a real number by 0. This is an arithmetic problem for which there is no solution, so the computer 
cannot calculate the result.

Float Inexact Result
The program tried solving an arithmetic problem for which the result cannot be precisely recorded using the computer's binary 
number system.

Float Invalid Operation
The program attempted invalid arithmetic, such as calculating the square root of -1 or dividing infinity by infinity.

Float Overflow
The program tried solving arithmetic which lead to numbers too large to be recorded in the computer's binary number system.

Float Stack Check
The program used up all of the math processor's internal storage space. This error can also occur if a program tries to get more 
numbers from the math processor's storage after it has been emptied.

Float Underflow
The program performed arithmetic which yielded denormalized (too small to represent) results.

Illegal Instruction
The program sent the CPU an instruction which is undefined. This means the program uses a code number which does not 
correspond to any known operation.

In Page Error
(Simulated) This error occurs if Windows temporarily stores away some of a program's data on disk and then cannot get it back 
when it is needed again.

Integer Divide By Zero
The program tried to divide the integer number 1 by 0. This is an arithmetic problem for which there is no solution, so the 
computer cannot calculate the result.

Integer Overflow
The program tried to solve arithmetic which lead to numbers too large to be recorded in the computer's binary number system.

Invalid Disposition
(Simulated) The program tried to solve another error for itself, but did not tell the system how it should then proceed.

Non-Continuable Exception
(Simulated) The program tried to continue after a serious error without fixing the problem which caused the error.

Privileged Instruction
The program tried to perform an operation which it does not have the right to do. For stability's sake, many important operations 
can only be performed by the system.

Single Step
Signaled the system that the program completed a single instruction. This occurs if the programmer forgot to remove commands 
he/she used to test a program.

Stack Overflow
The program used up all of the stack-type memory allotted to it. The stack refers to a program's short-term memory.

Unknown (or private)
The program generated an exception that is not a standard Windows exception.



Click here {button ,AL(`exceptions')}    for related information.



Answers to common questions
Where can’t CrashGuard catch a crash?

Although CrashGuard catches every type of crash, it cannot catch crashes in all locations within KERNEL32.DLL, VxDs, and 
certain device drivers. Certain errors must be handled by the system.

Why can’t CrashGuard fix every crash it catches?
CrashGuard can try to fix any crash it intercepts, but the damage might not be repairable. Frequently, an application cannot 
continue because:

It crashed after it has corrupted its data.
It cannot continue until some event occurs, but that event was interrupted by the crash.
It is a 16-bit application which has destroyed its stack.

When does Anti-Freeze not work?
As when fixing crashes, Anti-Freeze cannot help an application if:

It froze after corrupting its own data.
It has set itself into a special state which it cannot clear.
It does not know how to proceed because a required action was not completed.

How safe is CrashGuard?
CrashGuard is extremely safe. 

The 16-bit exception handler is also very safe in that it performs no background activity, does not hook onto other 
processes, and does not subclass

it is only called by Toolhelp (a part of Windows) when a crash occurs in a 16-bit application.
The application associated with the icon in the taskbar does nothing but bring up a menu when it is selected.

Click here {button ,AL(`ConnectSymantec',0,`',`')} for related information.



Dealing with crashes
When CrashGuard traps a crash, the Norton CrashGuard dialog box appears and lists:

The program that crashed.
The type of crash.

To view details about the crash:
Click Details to expand the dialog box and display some detailed system information about the crash. (To save this 

detailed information to a text file, click Save and specify a name and location for the file.)
To fix a crashed application:

If the application that crashed was working with data that you need to save, click Fix to let CrashGuard try to fix the 
problem. You should then return to the application, save the data it was working with, and exit the application.
To close a crashed application:

If the application that crashed was not working with data that you need to save, click Close to close the application. Any 
data that the application was working with will be lost.
Click here {button ,KL(`Exceptions',0,`',`')}  for related information.



Exception
A serious error which makes it impossible for a program to continue normally.



Frozen application
A software program that was running and is still on your screen, but does not respond to input from you or Windows.



Getting Technical Support and Information
To obtain the latest updates and patches for NORTON CrashGuard:

Click LiveUpdate in the Norton CrashGuard shield. See Updating CrashGuard.
Visit the Symantec World Wide Web site at:

http://www.symantec.com to obtain:
Technical Support
Answers to Frequently Asked Questions (FAQs)
Tips and Tricks

for NORTON CrashGuard and other Symantec products.
Click here 

    to connect to the Symantec Web site now!
Click here {button ,AL(`ConnectSymantec',0,`',`')}    for related information.



Opening CrashGuard
Installing CrashGuard sets it up to run every time you run Windows, providing you with constant protection from system crashes. 
CrashGuard is running if you can see the CrashGuard icon  in the taskbar. If it is not running, you can open it anytime.
To open CrashGuard:

Click Start, then Programs, Norton CrashGuard, and Norton CrashGuard.
Click here {button ,AL(`crashguard',0,`',`')}    for related information.



NORTON CrashGuard
Like what you see?

If you have been happy with the protection that NORTON CrashGuard provides, check out these other great system-
protection products from Symantec Corporation:

Norton Utilities™
The expert's choice for solving all computer problems.

PC Handyman™
A friend who solves your computer problems.

Healthy PC™
The one-button checkup for your PC.

Norton AntiVirus™
Automatic virus protection that eliminates the threat of viruses from Internet downloads, floppy disks, email, shared files, 
networks, and hard disks.

For more information:
Visit the Symantec Web site at http://www.symantec.com
Connect to the Symantec Web Site now!

OR
Visit your local software retailer.



Simulated exception
The CrashGuard Crash Test program simulates this exception and not actually generate it. Generating the exception either is not 
possible or would be too dangerous.



Testing CrashGuard
You can use CrashGuard to generate 16-bit or 32-bit exceptions. This lets you test the ability of CrashGuard (or any other crash-
protection software) to trap that type of crash and recover.
To test CrashGuard:
1 Right-click the CrashGuard icon  in the taskbar, then select Open. The CrashGuard shield appears.
2 Click Settings. The Norton CrashGuard Settings dialog box appears.
3 To generate either a 16-bit exception or a 32-bit exception, click the corresponding Test button. The Norton CrashGuard 
Crash Test dialog box appears.
4 Select the type of exception you want to generate.
5 Click Generate. To recover, see Dealing with crashes.
Click here {button ,AL(`exceptions;crashguard')}  for related information.



Uninstalling CrashGuard
To uninstall CrashGuard:
1 Click Start, then Settings, and Control Panel.
2 Double-click Add/Remove Programs.
3 In the list of installed software, double-click Norton CrashGuard. Follow the instructions in the Norton CrashGuard Uninstall 

wizard.
Note:

This removes all Norton CrashGuard files from your hard drive. If you want to use CrashGuard again, you will need to 
reinstall the software from the original disk(s).
Click here {button ,AL(`crashguard',0,`',`')}    for related information.



Updating CrashGuard
If you have a modem and/or an Internet connection (direct or dial-up), you can easily get the latest CrashGuard updates and 
patches using LiveUpdate.
To update CrashGuard:
1 Click Start, then Programs, Norton CrashGuard, and CrashGuard.
2 Click LiveUpdate.
3 Follow the instruction on your screen.
Click here {button ,AL(`ConnectSymantec',0,`',`')}  for related information.



Using Anti-Freeze
When an application appears to be frozen:
1 Right-click the CrashGuard icon  in the taskbar and select Anti-Freeze. (See notes.)

The Anti-Freeze window appears.
2 In the list of running applications, select the frozen application. (It will probably include "[Not responding]" in the label. See 

notes.)
3 Click Unfreeze to unfreeze the application so that you can save any unsaved data.

If this procedure does not unfreeze the application, see Closing a frozen application.
Note:

If the CrashGuard icon is not visible in the taskbar, you can launch Anti-Freeze by clicking Start, then Programs, Norton 
CrashGuard, and Norton CrashGuard. Then click Anti-Freeze.

If none of the applications in the list include "[Not responding]," your application might not be frozen. You might want to 
close Anti-Freeze and wait a little longer to see if your application "comes back."
Click here {button ,AL(`anti-freeze',0,`',`')}  for related information.



Viewing CrashGuard statistics
As CrashGuard traps crashes, it keeps track of:

How many crashes you have had.
How many freezes you have had.
Which applications and modules caused them.

To view these CrashGuard statistics:
1 Right-click the CrashGuard icon  in the taskbar.
2 Select CrashGuard Statistics from the pop-up menu.
Note:

The applications named TEST16.EXE and TEST32.EXE are CrashGuard's exception-generating programs that are run 
when you click Test in one of the Crash Test dialog boxes. If either application shows up in this list, those crashes were probably not 
encountered during normal computing.
Click here {button ,AL(`settings')} for related information.



What is Anti-Freeze?
Anti-Freeze is a program that can unfreeze a frozen application a program that was running and is still on your screen but is not 
responding to input from you or Windows.
When you notice that an application is frozen, you can pop up Anti-Freeze and unfreeze the application.
Click here {button ,AL(`anti-freeze',0,`',`')}  for related information.



What is LiveUpdate?
LiveUpdate connects you to the Symantec Internet site, downloads the latest CrashGuard updates and patches, and installs them 
on your PC. 
You must have a modem and/or an Internet connection (direct or dial-up) to use LiveUpdate.
Click here {button ,AL(`ConnectSymantec',0,`',`')}    for related information.



What is a frozen application?
A frozen application is a software program that was running and is still on your screen, but does not respond to input from you or 
Windows. Use Anti-Freeze to unfreeze a frozen application.
Click here {button ,KL(`frozen applications',1,`',`')}    for related information.



What is an exception?
The term "exception" refers to a serious error which makes it impossible for a program to continue normally. 
"Normal" errors

Many errors, such as trying to open a nonexistent file or save to a full floppy disk, are not exceptions because the program can 
simply tell you that a problem occurred and then continue. Even if a program asks the operating system to do something wrong, 
the operating system tells the program that the action was not taken, and the program can continue.

Exceptions
An exception, on the other hand, would occur if a program tried to perform undefined instructions. The program could not 
continue because the operating system would not know where to find the next valid instruction in the program. Exceptions can 
result from many different malfunctions, but in every case, the computer does not know what to do next.

Handling exceptions
A program can try to handle exceptions for itself using its own exception-handling routine, which essentially tells Windows, "Here
are my instructions for dealing with an emergency." Even so, the program can only deal with those exceptions for which it was 
specifically prepared, and only if it knows how to resolve the problem.

Norton CrashGuard can protect your system against exceptions generated by 16-bit and 32-bit applications.
Click here {button ,KL(`Exceptions',0,`',`')}  for related information.



Displays the 16-bit Crash Test dialog box from which you can generate 16-bit exceptions. This lets you test the ability of CrashGuard
to trap and fix the resulting crash.



Displays the 32-bit Crash Test dialog box from which you can generate 32-bit exceptions. This lets you test the ability of CrashGuard
to trap and fix the resulting crash.



Closes the dialog box without generating an exception.



Detailed CrashGuard statistics
This dialog box displays:

how many crashes you have had
how many freezes you have had
which applications and modules caused the errors

Note:
The applications named TEST16.EXE and TEST32.EXE are CrashGuard's exception-generating programs that are run 

when you click Test in one of the Crash Test dialog boxes. If either application shows up in this list, those crashes were probably not 
encountered during normal computing.



Displays detailed information about the crashes CrashGuard has trapped and the frozen applications it has unfrozen.



Displays the number of intercepted crashes and unfrozen applications.



Lets CrashGuard trap and fix crashes caused by 16-bit applications.
If you do not use any 16-bit applications (for example, older programs written for Window 3.x), you can leave this unchecked.



Enhances the Close Program dialog box (which appears when you press Ctrl+Alt+Del) to include an Anti-Freeze button. This lets 
you apply Anti-Freeze to a frozen program even if the entire system stops responding. This option does not apply to Windows NT 
users.



Lets CrashGuard trap and fix crashes caused by 32-bit applications.



Generates (or simulates) an exception of the type selected in the list above.




